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Chapter 1: Introduction to IGSS Maintenance
1.1 What is IGSS Maintenance ?
Purpose
The purposes of this program are:
l

to ensure that regular maintenance is performed on the process components to avoid unnecessary
downtime

l

to ensure that the process components have an optimal lifetime through regular maintenance

Use
Two types of users utilize this program:

This type of user …
System designer1

will typically …
n

create maintenance jobs

n

provide maintenance instructions to the operator

n

attach alarm texts to the maintenance jobs

n

customize the maintenance list

n

Operator1

n

n

n
n

control user access to protected functions in the Maintenance module
acknowledge maintenance alarms (either in the maintenance list
or the alarm list)
View maintenance instructions and perform the related maintenance on the process components
complete the maintenance alarm
write a maintenance note, if something unusual occurs while performing maintenance

The maintenance database (Mntdb.mdb)
When you create or edit maintenance jobs, the related information is written into the maintenance database, Mntdb.mdb. This file is located in the report folder for the active configuration.The maintenance
information can also be saved in an SQL Server. For further details, refer to the System Configuration
help file.

1 The system designer is the person who builds an image of the monitored process and makes sure that

data can be received from and sent to the process components. The system designer is typically a highly
skilled engineer who uses a number of IGSS programsto build the configuration that the operators will later
use when monitoring and controlling the plant. The system designer's main progam is the Definition program.
1 The operator is the person who monitors and controls the monitored process. He will typically only use the
Supervise and Alarm programs. These two programs are designed to make the monitoring task very easy
and straightforward for the operator.
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For further details about the database, refer to the Interface Help file.

1.2 Key features and benefits
Introduction
This topic gives you an overview of the most important features in the Maintenance module. The features
are divided into two groups representing the main user types: system designer and operator.

System designer tasks
The system designer will typically use the following functions. For more detailed information, click the individual features:

This feature …

allows the system designer to …

Create and edit maintenance
jobs

specify a maintenance interval for a specific process component, for
example, a pump to ensure regular maintenance.

Provide operator instructions

attach maintenance instructions to the maintenance job. The instructions may be text, a file (video clip, Word document, etc.) or a Help file.
The operator will use these instructions to perform the maintenance job.

Attach alarm texts

attach alarm texts to a maintenance job so that the maintenance alarm
appears in the alarm list. Thus, the maintenance alarm will appear both
in the maintenance list and the alarm list.

View the job status

view up-to-date information on each maintenance job, including the
time for latest measurement, latest acknowledge time, latest completion time, etc. The operator can, of course, also view this information.

Create filters

create user-defined filters that the operator can apply during supervision. A filter is a condition or a set of conditions to be applied to the
maintenance list. You may, for example, only want to show the active
maintenance alarms for a specific area of the IGSS configuration.

Customize the list

define the column sequence in the maintenance list, which columns to
be shown and their titles.

Control user access

control user access to protected functions in the program. This requires
that the proper rights are defined in the User Administration form.
The following functions can be protected:
n

create and edit maintenance jobs

n

protect filters

n

acknowledge maintenance alarms

Operator tasks
The operator will typically use the following functions:
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This feature …

allows the operator to …

Acknowledge maintenance
alarms

acknowledge maintenance alarms either in the maintenance or alarm list

View maintenance instructions

view the maintenance instructions provided by the system designer. This
may be a textual description, a video clip, a Help topic, etc.

Complete maintenance
alarms

complete maintenance alarms, once the related maintenance job is performed. On completion, a new maintenance interval is begun.

Apply filters

use filters to limit the number of maintenance alarms shown in the list.
The filters are normally defined by the system designer.

1.3 Maintenance User Interface
Maintenance User Interface
Before you start using the Maintenance module, we recommend that you spend a few minutes getting familiar with the user interface.
The picture below shows the user interface elements of the Maintenance form.

-3-

IGSS V12, User Guide

Elements in the Maintenance interface
Here is a short description of each element in the user interface. These will also be explained more thoroughly later in the help file.
#

Element

Description

The application button lets you create a new Maintenance job. Click "Creating
maintenance jobs" on page 9 to see how to create a Maintenance job.
Also general print and print setup are available.

1

Application button1

There are two context sensitive Ribbons:

2

Ribbon1

The "Job Handler Ribbon" on page 5 lets you acknowledge, complete, and restart
maintenance jobs and more. In short, handling of jobs.
The Configuration Ribbon lets you create and edit maintenance jobs and filters.
You can also view information about the jobs and format the maintenance list containing the jobs.

3

Filtered views

View filters gives you an overview of the different filters you got. There are two
main categories: Maintenance Jobs Due and All Maintenance Job
Maintenance Jobs Due shows all the active maintenance alarms, that is, the ones

1 The Application button, nicknamed "doughnut", is located in the upper left corner of the module's window.

Click the button to access the application menu. The menu contains items that were typically found in the
File menu in previous versions of IGSS. In most modules, an "Options" item allows the user to define global
module settings. The Application button is a new term introduced with the .NET platform and used in, for
example, the Microsoft Office 2007 package.
1 The Ribbon is a new term/element in the Microsoft universe. The Ribbon replaces the well-known toolbars
in applications. The Ribbon provides quick access to the most commonly used functions in the application.
The Ribbon is divided into logical groups (the tabs) and each tab is divided into sections (the blocks in the
tab). The Ribbon is context-sensitive which means that only relevant functions are accessible dependent
on the current user action.
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#

Element

Description

that have not been completed yet.
All Maintenance Jobs shows you all the jobs, that is, maintenance jobs which have
been created but are not in alarm and all maintenance alarms which have been
completed.
When you define a filter, it will belong to one of the two main groups. You must
then click the + sign to view the filters. In the example, filters have been defined
in both groups. To apply a filter, simply click its name.
There will here be displayed the jobs, the filter you have chosen allows.
4

Job View

5

Text field

This text field can display either a note or a description of the job.

6

Status Bar

This bar displays the last measured time.

You can choose the columns you want to display and also change the order of
them.

Job Handler Ribbon

Field Help
Fields

Description

Acknowledge

Acknowledge the selected job.

Complete

Complete the selected job. The job will disappear from the Maintenance Jobs Due list.

Restart

Restart the selected job.

Refresh List

Refresh the list if you made a change which does not appear in the list.

Print

Make a print of your selected job(s) and then select what you want in
the print: job list data, job description and job notes.

Open Job Note

Opens the Note text for the selected job.

View Description

Displays the description of the job if there is any.
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Fields

Description

Find in Supervise

Finds the associated object in Supervise and displays it.

Configuration Ribbon

Field Help
Field

Description

Allows you to create a new maintenance job. This is a two-step procedure: first you select the relevant process component (IGSS object),
then you define the maintenance job by specifying the type of the job
(periodical, used time, changes, counter), and providing operator
instructions, etc. You can also select type of job first, from the drop
down menu shown.

New Job

Click here for more info on creating maintenance jobs
Allows you to change almost everything in the selected job: the name,
the alarm fired when the job is due, the maintenance interval.
Edit Job
Its also possible to attach some files to the job if you didn't done it
when you created the job.
Edit Information

Allows to edit the attached files of the job.
Create a new filter. Give it a name and enter some conditions.

New Filter
You can customize your conditions with the condition editor.
Default

Set the selected filter as default. It means that this filter will be applied
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Field

Description

when you start maintenance.
Edit

Edit the selected filter.

Delete

Delete selected filter.

Format Columns

Allows you to choose the columns you want to display and in which
order.
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Chapter 2: Workflow in Maintenance
2.1 Overview: the complete workflow
The flowcharts below show the complete life cycle of a maintenance job.
The system designer creates and maintains the job and the operator handles the maintenance alarms.

System designer tasks

Operator tasks
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Chapter 3: System Designer Tasks
3.1 Overview
Creating maintenance jobs
The system designer creates the maintenance job. The job definition contains a maintenance interval for a
specific process component, for example, a pump. The job also contains maintenance instructions for the
operator.
When the specified maintenance interval expires, the operator will get an alarm to make sure that the
requested maintenance is performed in due time. The operator will then acknowledge the alarm, perform
the actual maintenance job and then complete the alarm. Once completed, a new maintenance interval is
started.

Creating a maintenance job
You can create a maintenance job for the analog, digital and counter IGSS object types, defining maintenance job types depending on the IGSS object selected. Some maintenance job types can only be
applied to certain IGSS object types.
When you create a maintenance job you must first select the relevant process component (IGSS object)
and define the maintenance job type (periodical, used time, changes, counter).
You can select the object first and define the job type afterwards, or define the job type first and then select
the object afterwards.
Once the job type has been defined and the object selected, you must define the job specific parameters,
for example providing operator instructions or setting in the New <Job type>Job form.
Identical job types on the same object with the same alarm number

While you can create maintenance jobs of the same job type on the same object and assign them the same
alarm number, it will not be possible to differentiate between the maintenance jobs when they are triggered
in the Active Alarms form. You must open the Maintenance form in order to determine which maintenance
job is active.

If IGSS User Administration is enabled, the current user must have the Can Define right to create
maintenance jobs.

The New Job form
The contents and fields of this form depend on which job type you selected. For example, if you chose a
Periodical job, the form title will be named New Periodical Job.
The New <Job Type> Job form is used to define the job specific parameters for that maintenance job.
You can have more than one job of each type (periodical, used time, changes or counter) applied to one
object.
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See Also

Used Time maintenance
Counter maintenance
Periodical Maintenance
Changes maintenance

Attaching alarm texts
If you attach an alarm number and alarm text to a maintenance job, an alarm will be triggered in the
Alarm List form when the maintenance job is due. The maintenance alarm in the Alarm List form will be
marked with a maintenance icon, indicating that the alarm originated from a maintenance job.
When you acknowledge the maintenance alarm in the Alarm List form, the maintenance job in the Maintenance form will automatically be acknowledged as well.
There are several good reasons why you should attach an alarm text to a maintenance job:
l

the alarm will be visible in the alarm list and directly on the process diagrams

l

the operator can handle maintenance alarms either from the maintenance list or the alarm list

l

the color used in the maintenance list and alarm list will reflect the colours defined for the alarm
text (alarm and acknowledge colours)

STEP 1: Create the alarm text in Definition
Before you start creating maintenance jobs, it is recommended to create the new maintenance-related
alarm texts first. This is done in Definition by selecting Edit → Alarm Texts and then clicking New.
l

It is not possible to create or edit alarm texts from Maintenance.

STEP 2: Attach the alarm text in Maintenance
Once an alarm text is defined in Definition, you can attach it to a maintenance job simply by selecting it in
the Alarm Text drop-down list in the New Job dialogue.

How the operator handles alarms
When the specified maintenance interval expires, an alarm will occur in the maintenance list and in the
alarm list. The operator then acknowledges the alarm and performs the maintenance job as described in
the operator instructions. When the maintenance is done, he will complete the alarm in the maintenance
list.
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Providing operator instructions
Purpose
To make sure that a maintenance job is performed correctly and consistently by the plant operators, you
must supply precise and adequate step-by-step instructions.

How to present instructions
There are three ways to present maintenance instructions as follows:
l

Write a detailed maintenance instruction yourself (Job Description tab)

l

Attach a file that describes or shows the maintenance instructions. This could be an electronic manual
from the component manufacturer, a video file showing the instructions, etc. (File tab)

l

Attach a Help topic that describes the maintenance instructions (Help File tab)

The Maintenance Information dialogue
The figure below shows the Job Information dialogue. Click on any of the four tabs for further information.

Viewing the job status
Purpose
Once you have created a maintenance job, you may want to view its status from time to time. You will then
get details about the latest alarm time, latest acknowledgement time, etc.

Accessible to both system designer and operator
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You have an overview of the job status with the list of all the different columns displayed all the time at the
bottom of Maintenance.
You have the possibility to customize the columns you want to be displayed, by clicking on Format
Columns under the Configuration tab.
For further details about the customization go to "Customizing the list" on page 13

Creating filters
Purpose
By defining filters you can obtain the following advantages:
l

allow the operator to select what he wants to view in the maintenance list by clicking the name of
the filter
(for example, all maintenance alarms in a specific area of the configuration.)

l

limit the maintenance list to show only those maintenance jobs that fulfil certain conditions (for
example, all maintenance alarms acknowledged yesterday).

How to define filters
You can define a new filter by selecting one of the two sections in the tree view (Maintenance Jobs Due
or All Maintenance Jobs) and clicking the New Filter button to open the Filter Setup form.
Give the filter a descriptive name and add the conditions you want the filter to apply to the list.

Protecting filters
You can protect a filter from unauthorized use by checking the Protect box. When enabled, the rights of
the current user will be checked and he can only edit the filter, if he has the Can use system commands
user right in his profile (user group).

To enable the protection, you must define the relevant user groups, rights and users in the User
Administration module. Open the User Administration Help file for further information.
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The Filter Setup dialogue
The figure below shows the above dialogue.
l

For an explanation of the individual items in the dialogue, click the
in the upper right hand
corner of the dialogue, then click the item you want information about.

Customizing the list
Purpose
You may want to customize the maintenance list for the following reasons:
l

You want to change the column sequence to show the columns that are most important for you first

l

You want to change the sort order to show the most important maintenance alarms first

Maintenance includes two functions for these purposes as described below.

Changing the column sequence, column names, etc.

To customize the list, click the
button under Configuration, to open the Format Columns dialogue shown below. In this dialogue, you decide exactly which columns to show, their order and even their
names.
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For an explanation of the individual items in the dialogue, click the
in
the upper right hand corner of the dialogue, then click the item you want
information about.

Changing the sort order
To change the order of the columns, you just have to click on the Move Up and Move Down buttons.

Controlling user access
You can use the IGSS User Administration module to set up user rights in order to protect key functionality
and functions in Maintenance from unauthorized use.
You can increase the security by using the IGSS Object Level Protection scheme to further increase the
Maintenance module's user permissions.
The protection only works, if you have defined the relevant user groups, rights and users in the User Administration module and set up Object Level Protection for the affected objects.
User Administration setup

You can set up the IGSS User Administration module to improve general Maintenance module security for
the following functions:

To use this function …

Define, edit and delete maintenance jobs

you must have this right (defined in
User Administration) …

Can edit maintenance jobs
(typically system designer)

Edit Maintenance job description and main- Can edit maintenance jobs
tenance job note entries
(typically system designer)

- 14 -

IGSS V12, User Guide

you must have this right (defined in
User Administration) …

To use this function …

Note: This setting is disabled by
default and must be enabled in the
Registry settings of the local machine.
Edit protected maintenance filters

Can use system commands
(typically system designer)
The Protect check box on the Filter
Setup form must be selected for each
filter which is to be protected.

Object Level Protection

In addition to improving the general Maintenance module security, you can also provide an added layer of
security by using the Object Level Protection, specifying for each object the following Maintenance functions:

select this Object
Level Protection
security level

To use this function …

Can acknowledge maintenance alarms in the Active
Alarms form or in the Maintenance form.

Can acknowledge
alarms
(typically operators)

Can register maintenance jobs as complete

Can acknowledge
alarms
(typically operators)

Example of security roles
The example below illustrates how user rights and object level protection security levels can be assigned
to various operator roles in the Maintenance module:

This user group …

Administrator

System Designer

Operator

has the following User rights …
l

Can define

l

Can edit Maintenance jobs

l

Can administer

l

Can use system commands

l

Can define

l

Can edit Maintenance jobs

l

Can use system commands

l

Can acknowledge alarms (Object Level Protection security
option)
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Once everything is set up properly, the rights of the user who is currently logged in will be checked. If a
user tries to perform an operation that he is not entitled to do, the Temporary Login dialogue appears
allowing another user with the necessary right to log in.

See Also

"Enable user rights management for job notes" on page 24
"Enable mandatory Complete notes" on page 25
"Create a new filter" on page 21

3.2 How To...
Create and Edit Maintenance Jobs
Create a new maintenance job
Maintenance jobs can be created analog, digital and counter objects, although some maintenance job
types can only be created for specific object types, for example Used time jobs can only be created for
digital objects .
When you create a new maintenance job, you can choose between:
l

Creating a maintenance job for a new object

l

Creating a maintenance job based on an existing object

l

Creating a maintenance job based on an existing job

If user administration is enabled, you must have the Can define right to create a maintenance job. If
you do not have this right, the Temporary Login dialogue appears.

Creating a maintenance job for a new object

1. Click on the New Job button to open the Object Selection for Maintenance job form1.
2. In the Job Type group, select the type of maintenance job you want to create:
l

Periodical (analog, digital or counter objects)

l

Counter (analog or counter objects)
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l

Used Time (digital objects)

l

Changes (digital objects)

3. In the Objects list, select the Indicator object for the Maintenance job.
If necessary, use the filter to find the object you want.

4. Click the OK button to select the object and open the New <Jobtype> Job form where you
can set up the parameters of the new maintenance job.
The job type is displayed in the <JobType> placeholder in the form title.

1 You can also select the drop-down list in the

New Job button and select the job type directly

See Also

"Creating a Maintenance Job based on an existing object" on page 17
"Creating a Maintenance job based on an existing job" on page 18
"Creating maintenance jobs" on page 9

Creating a Maintenance Job based on an existing object
When you create an maintenance job based on an existing object, you can create a new identical job type
for the same object or create a different job type for the same object.
You cannot change the Indicator object but can change the Maintenance object and other job type specific
parameters.

You should change the job title in order to differentiate between maintenance jobs in the job list.

Create an identical job type for the same object

1. Select an existing job in the job list of the Maintenance form.
2. Click the New Job on same object button in the Maintenance form ribbon to open the New
<Jobtype> Job form.
3. In the New <Jobtype> Job form, you can:
l

Change the job title in the Title field

l

Change the Maintenance object by clicking the Change button and selecting a new maintenance object.
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l

Change the maintenance job descriptions, job notes and add or remove any attached job files
or help files in the Job Description, Job Note, Files/Folder and Help File tab pages.

l

Change any job type specific parameters, for example defining a new periodic interval for Periodical job types or defining a counter limit for Counter job types

4. Click the OK button to save the job parameters and create the new job.

Create a different job type for the same object

1. Select an existing job in the job list of the Maintenance form.
2. In the drop down list for the New Job on same object button in the Maintenance form ribbon, select the job type you want to create.
3. The New <Jobtype> Job form opens where the selected job type is displayed in the
<JobType> placeholder in the form title..
4. In the New <Jobtype> Job form, you can:
l

Change the job title in the Title field

l

Change the Maintenance object by clicking the Change button and selecting a new maintenance object.

l

Define or Change the maintenance job descriptions, job notes and add or remove any
attached job files or help files in the Job Description, Job Note, Files/Folder and Help
File tab pages.

l

Define any job type specific parameters , for example defining a new periodic interval for Periodical job types or defining a counter limit for Counter job types

5. Click the OK button to save the job parameters and create the new job.

See Also

"Creating maintenance jobs" on page 9
"Creating a Maintenance job based on an existing job" on page 18

Creating a Maintenance job based on an existing job
When you create a maintenance job based on an existing job, you can create a new identical job type for
the same object or for different objects.
You can change the job parameters and the Indicator and Maintenance objects, but cannot change the job
type.
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You should change the job title in order to differentiate between maintenance jobs in the job list.

Create a maintenance job based on an existing job

1. Select an existing job in the job list of the Maintenance form.
2. Click the New Job as clone button in the Maintenance form ribbon to open the New <Jobtype> Job form.
3. In the New <Jobtype> Job form, you can:
l

Change the job title in the Title field

l

Change the Indicator object by clicking the Change button by the Indicator object field and
selecting a new indicator object.

l

Change the Maintenance object by clicking the Change button by the Maintenance object
field and selecting a new maintenance object.

l

Change the Maintenance job descriptions, job notes and add or remove any attached job files
or help files in the Job Description, Job Note, Files/Folder and Help File tab pages.

l

Change any job parameters, for example defining a new periodic interval for Periodical job
types or defining a counter limit for Counter job types

4. Click the OK button to save the job parameters and create the new job.

See Also

"Creating maintenance jobs" on page 9
"Creating a Maintenance Job based on an existing object" on page 17

Edit maintenance jobs

If user administration is enabled, you must have the Can define right to edit maintenance jobs. If
you do not have this right, the Temporary Login dialogue will appear.

1. Select the maintenance job you want to edit in the maintenance list.

2. Click

.

3. Change the properties, as required.
4. Click OK.
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To delete a maintenance job, right-click on the job you want to delete and
click delete.

Delete maintenance jobs

If user administration is enabled, you must have the Can define right to delete maintenance jobs. If
you do not have this right, the Temporary Login dialogue will appear.

1. Select the maintenance job you want to delete in the maintenance list.
2. Right-click on the job you want to delete and click delete.

View the job status
You can gain a quick overview of the status of the maintenance jobs by looking at the Value, Progress
and Due In columns in the Job List in the Job Handler form.
l

The Value column displays the interval or changes which the maintenance job is measured in. If
the maintenance job is overdue, the display color will be red. Otherwise the display color of the
value column is blue.

l

The Progress column displays the status of the present maintenance job and presents an estimate
of how much of the maintenance job remains until it is due. The progress bar is green if the maintenance job is less 90% due. If the maintenance job is more than 90% due, the progress bar will be
brown and if the If the maintenance job is overdue, the progress bar will be red.

l

You can gain overview when the maintenance job is due in the Due In column. Maintenance jobs
that are due shortly can sometimes be completed prior to their scheduled start if the plat is large or
if it makes sense to collect all maintenance jobs for one section or piece of machinery.

l

You can see if a job has been acknowledged or completed if there are dates in the Acknowledged
and Completed columns.

Click the Find in Supervise button to open the diagram and go directly to
the object in the maintenance job list to gain an overview of the status of
the controlling object. The Supervise module must be started in order to
be able to open the diagram.
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Create and Edit Filters
Create a new filter

1. Select the section in which you want to create a filter (Maintenance Jobs Due or All Maintenance Jobs).
2. Click the New Filterbutton to open the Filter Setup form.
3. In the Filter name box, type a descriptive name for the filter.
4. In the Condition Editor group, select the first condition you want to use and click Add. For
example, area name begins with “G”.
5. Repeat step 4 for all the conditions you want to use. For each condition, you can specify whether
it is an And or Or condition.
6. If necessary, check Protect to protect the filter from unauthorized use.

A protected Maintenance filter will require a user to have the Can use system commands user right defined in the User Administration module
in order to edit the filter.

7. Click OK.

You can negate all filter conditions by checking the Not box. For example,
to show all maintenance jobs that do not belong to the Global area, create
a filter where area name is exactly Global and then negate the expression.
See Also

"Delete a filter" on page 22
"Edit a filter" on page 21
"Filter Setup Form" on page 48
Edit a filter

1. Select the name of the filter you want to edit in the tree view.
2. Right-click on the filter you want to edit and click Edit Filter or click the Edit button in the Filter group.
3. Do one of the following:

l

To create a new condition, define it in the Condition Edition group and click Add.
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l

To change a condition, select that condition in the list, then edit the properties in the Condition Edition group and click Change to apply the changes.

3. When you are satisfied with the filter, click OK.

If the filter is protected, you must have the Can use System Commands right to edit the filter.
User rights are defined in the User Administration module.
See Also

"Create a new filter" on page 21
"Delete a filter" on page 22

Delete a filter

A protected Maintenance filter will require a user to have the Can use system commands user right defined in the User Administration module
in order to delete the filter.

1. Select the name of the filter you want to delete in the tree view.
2. Right-click on the filter and click Delete Filter or click the Delete button in the Filter group.

See Also

"Create a new filter" on page 21
"Edit a filter" on page 21

Customize the List
Customize the list format
If you want to adjust the columns in the maintenance job list, change the column sequence, rename
columns and remove or add columns to the list, use the following procedure:
In the Configuration tab, click the Format Columns button to open the Format Columns form.
l

To change the column sequence, select the name of the column you want to move and click the
Move Up or Move Down buttons to adjust the placement of the selected column.
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l

To remove a column from the job list, select the column in the Displayed pane and click the
<Remove button. The selected column is removed from the Display pane and appears in the
Available pane.

l

To change a column name, select the column and enter the new name in the Custom Name field.

l

To set an exact column width, select the column and enter an exact width in pixels in the Width
field.

l

To reinstate a column that has been removed, select the column in the Available pane and click
the Add> button.

l

To return to the default column sequence and names, click the Reset button.

Tips

Change the sort order
To change the sort order of the maintenance job list, right-click the column headers. By clicking in the
column headers, you can toggle between ascending or descending sorting.
The sort order will automatically be reset when the Maintenance form is closed.

Control User Access
Define user rights
If you want to protect certain functions in the Maintenance module, you must define the relevant user
groups and user rights in the User Administration module in the IGSS Master
For more information regarding User Administration, see the User Administration online help found in
the Help pane of the IGSS Master.
See Also

"Controlling user access" on page 14

Change display mode for the Maintenance Job Form
There are two display modes which can be applied to the Maintenanceform:
l

Basic

l

Advanced

The Maintenance form is by default started in Advanced mode, where an operator or system designer can
create , edit and delete new maintenance jobs as well as create, edit and delete filters by using the buttons
on the Configuration tab.
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You can change the default start mode of the Maintenance form to Basic. Displaying the Maintenance
form in Basic mode will remove the Configuration tab from the form.
The following functions will not be accessible when the Basic mode is enabled:
l

Create new maintenance jobs

l

Edit existing maintenance jobs

l

Delete maintenance jobs

l

Create new filters

l

Set existing filters as defaults

l

Edit existing filters

l

Delete filters

l

Edit maintenance job information

l

Format and change columns of the Maintenance form

To set display mode to Basic

1. Open the Registry Editor form on the local machine. Click Start and type "Regedit.exe" in the
search field of the Windows Start menu.
2. In the Settings folder in HKEY_CURRENT_USER\Software\Schneider Electric\IGSS32\V12.00.00
\ Mnt32, right-click on the SimpleMode key and select Modify.
3. In the Value Data field of the Edit String form, enter the value "0" and click the OK button to
save.
4. Click File > Exit to exit the Registry Editor form and save the registry values.

To set display mode to Advanced

1. Open the Registry Editor form on the local machine. Click Start and type "Regedit.exe" in the
search field of the Windows Start menu.
2. In the Settings folder in HKEY_CURRENT_USER\Software\Schneider Electric\IGSS32\V12.00.00
\ Mnt32, right-click on the SimpleMode key and select Modify.
3. In the Value Data field of the Edit String form, enter the value "1" and click the OK button to
save.
4. Click File > Exit to exit the Registry Editor form and save the registry values.

Enable user rights management for job notes
Users are by default permitted to create and edit Maintenance job note entries as well as editing the Maintenance job description.

- 24 -

IGSS V12, User Guide

If you have enabled user rights management for your IGSS installation and you are using the User Administration functionality to manage user rights for the Maintenance module, you can connect user access to
job notes and job descriptions to the Can edit Maintenance jobs user right by enabling the
ReqEditPwd Windows registry key setting for the local machine.
The ReqEditPwd Windows registry key is disabled by default.

To enable the ReqEditPwd registry key

1. Click Start and type "Regedit.exe" in the search field of the Windows Start menu to open the
Registry Editor form on the local machine.
2. In the left pane of the Registry Editor form, click HKEY_CURRENT_USER\Software\Schneider
Electric\IGSS32\V12.00.00\Mnt32_HKLM.
3. In the right pane, right-click the ReqEditPwd registry key and select Modify to open the Edit
DWORD Value form.
4. In the Value data field, enter "1".
5. Click the OK button to close the Edit String form
6. Close the Registry Editor form to save the new registry setting.

To disable the ReqEditPwd registry key

1. Click Start and type "Regedit.exe" in the search field of the Windows Start menu to open the
Registry Editor form on the local machine.
2. In the left pane of the Registry Editor form, click HKEY_CURRENT_USER\Software\Schneider
Electric\IGSS32\V12.00.00\Mnt32_HKLM.
3. In the right pane, right-click the ReqEditPwd registry key and select Modify to open the Edit
DWORD Value form.
4. In the Value data field, enter "0".
5. Click the OK button to close the Edit String form
6. Close the Registry Editor form to save the new registry setting.

See Also

"Controlling user access" on page 14
"Enable mandatory Complete notes" on page 25

Enable mandatory Complete notes
The system designer can enable mandatory Complete notes for the Maintenance module.
When mandatory Complete notes are enabled, the user is prompted to provide a note whenever the user
completes a maintenance job (selects a maintenance job and clicks the Complete button)
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To enable mandatory Complete notes

1. Open the Registry Editor form on the local machine. Click Start and type "Regedit.exe" in the
search field of the Windows Start menu.
2. In the Settings folder in HKEY_CURRENT_USER\Software\Schneider Electric\IGSS32\V12.00.00
\ Mnt32, right-click on the Requires Complete Note key and select Modify.
3. In the Value Data field of the Edit String form, enter the value "1" and click the OK button to
save.
4. Click File > Exit to exit the Registry Editor form and save the registry values.

To disable mandatory Complete notes

1. Open the Registry Editor form on the local machine. Click Start and type "Regedit.exe" in the
search field of the Windows Start menu.
2. In the Settings folder in HKEY_CURRENT_USER\Software\Schneider Electric\IGSS32\V12.00.00
\ Mnt32, right-click on the Requires Complete Note key and select Modify.
3. In the Value Data field of the Edit String form, enter the value "0" and click the OK button to
save.
4. Click File > Exit to exit the Registry Editor form and save the registry values.

Set up default Pending percent
You can use the command line interface to print a list of maintenance jobs that are nearly due from the Job
scheduler or by using a Windows command prompt. The command line parameter that is used to do this is
the -soon parameter.
The -soon parameter only includes active jobs that are considered to be nearly due.
A job is considered to be nearly due if the maintenance job progress percent is equal to or above the value
defined in the Maintenance pending at... field of the Maintenance job form. The default value being
95 percent, but you can change the default value

To change the default Pending percent

1. Open the Registry Editor form on the local machine. Click Start and type "Regedit.exe" in the
search field of the Windows Start menu.
2. In the Settings folder in HKEY_CURRENT_USER\Software\Schneider Electric\IGSS32\V12.00.00
\ Mnt32, right-click on the DefaultSoonPercent key and select Modify.
3. In the Edit String form, select the Decimal option.
4. In the Value Data field of the Edit String form, select the Decimal option and enter the
required new default value and click the OK button to save.
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5. Click File > Exit to exit the Registry Editor form and save the registry values.

See Also

"Maintenance: CommandLineInterface" on page 33
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Chapter 4: Operator Tasks
4.1 Create Maintenance Job
Create a Maintenance Job in Supervise
An operator can create a maintenance job from an object in Supervise by right-clicking the object in the process diagram and selecting New Maintenance Job.
If the Maintenance module is not already running, it will be started and the Select Job type and Indicator object form will be opened.
The object selected in the Process diagram is the Maintenance object and the operator can select another
object to be the Indicator object in the Select Job type and Indicator object form.
See Also

New/Edit Maintenance Job

4.2 Handle Maintenance Jobs
Acknowledge maintenance jobs
To acknowledge a Maintenance jobs, select the job you want to acknowledge in the maintenance list in the
Job Handler tab of the Maintenance form and click on the Acknowledge button.
If there are multiple Maintenance jobs you want to acknowledge, you can select all the jobs and click on
the Acknowledge button

Tips
l

You can also right-click in the list and select Acknowledge.

View maintenance instructions
If a maintenance job contains additional instructions, the View Job file or
View job Help buttons will be displayed in the Job documents group in the
Job Handler tab.

1. In the Job Handler tab, select the maintenance job for which you want to view instructions.
2. Click the Open Job Notebutton in the Job Documents ribbon to open the Note pane in the
right side of the screen.
3. In the Note Pane, write the note to the active Maintenance job.
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4. Close the Note pane by clicking the [X] in the upper-right hand corner. A note icon will appear
on the maintenance job in the job list.
5. If a job description or job file has been attached to the Maintenance job, a View Description
button and/or the view job filebutton will be accessible in the Job Handler tab.

Tips
l

You may want to print the instructions to have them at hand when you perform the physical maintenance on the process component.

Complete maintenance jobs
Only maintenance jobs that have been acknowledged can be registered as completed.
To register a maintenance job as completed, select the job in the maintenance list in the Job Handler tab
of the Maintenance form and click the Complete button.
If there are multiple Maintenance jobs that are completed, you can select all the jobs and then click on the
Complete button.
The selected maintenance job will become red to indicate that it has been completed. Once completed, a
new maintenance job is often initiated, depending on the maintenance job parameters.

Tips
l

You can also right-click on the maintenance job in the list and select Complete.

Attach maintenance notes
Job notes can be used to document your work and progress on the maintenance job, to document unusual
occurrences or special situations or if you deviate from the maintenance job instructions. You can edit job
notes from within IGSS but since job notes are saved as text files on the local machine, you can edit the
job notes without starting IGSS by using a text editor .
You can attach notes to the maintenance jobs in the job list.

1. In the Job Handler tab of the Maintenance form, select the maintenance job to which you
want to attach a note.
2. Click the Open job notebutton. The job note text field appears on the right side of the Maintenance form
3. Write the maintenance note in the text field at the bottom of the Note tab.
4. Click the Add note button to create the note.

Tips
l

It is recommended to include your initials and the current date before the note itself. This will make
it much easier to track notes for a maintenance job.
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Print the maintenance list

1. Select the Application menu> Print or click the Print button in the job handler tab. The
Print jobs dialog appears.
2. In the Print jobs dialog, decide what you want to print by checking the checkboxes:

l

Include job list data

l

Include job descriptions

l

Include job notes

3. In the Printdialog, select the print quality, number of copies, etc. Use the print setup to customize your print.
4. Click the Print button to start the print job.

Tips
l

If you want to print to another printer, select the appropriate printer in the Print dialogue. In the
setup dialogue, you can also change the paper size and orientation (Portrait or Landscape).

View the job status
You can gain a quick overview of the status of the maintenance jobs by looking at the Value, Progress
and Due In columns in the Job List in the Job Handler form.
l

The Value column displays the interval or changes which the maintenance job is measured in. If
the maintenance job is overdue, the display color will be red. Otherwise the display color of the
value column is blue.

l

The Progress column displays the status of the present maintenance job and presents an estimate
of how much of the maintenance job remains until it is due. The progress bar is green if the maintenance job is less 90% due. If the maintenance job is more than 90% due, the progress bar will be
brown and if the If the maintenance job is overdue, the progress bar will be red.

l

You can gain overview when the maintenance job is due in the Due In column. Maintenance jobs
that are due shortly can sometimes be completed prior to their scheduled start if the plat is large or
if it makes sense to collect all maintenance jobs for one section or piece of machinery.

l

You can see if a job has been acknowledged or completed if there are dates in the Acknowledged
and Completed columns.

Click the Find in Supervise button to open the diagram and go directly to
the object in the maintenance job list to gain an overview of the status of
the controlling object. The Supervise module must be started in order to
be able to open the diagram.
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Handling maintenance alarms
When a maintenance alarm occurs, two things happen:
l

the alarm is shown in the Active Maintenance Objects section in the maintenance list and

l

the alarm is shown in the All Active Alarms section of the alarm list (provided that an alarm
text was attached to the maintenance job)

The operator can handle the maintenance alarm as follows:
Acknowledge the alarm

To acknowledge an alarm, select the alarm in either the Maintenance job list or the Active Alarms form
and click the Acknowledge button
View maintenance instructions and perform the job

Before you perform the maintenance, select the maintenance job, and click the Info button to view the
instructions.
Dependent on what kind of instruction the system designer has provided, you will find it on the Job
Description, Link or Help file tab.
You may want to print the instructions to bring them with you, when you perform the physical maintenance
job.
Complete the job

When the maintenance job is done, select the alarm in the list and click the Complete button.
Attach a maintenance note (Optional)

If necessary, you can attach a note to a maintenance job, writing any necessary information relevant to
the maintenance job.
Select the job and click the Note button. On the Job Note tab, you can write the note in the text field and
click the Add Note button.
See Also

"Acknowledge maintenance jobs" on page 28
"Apply a filter" on page 32
"Attach maintenance notes" on page 29
"Complete maintenance jobs" on page 29
"Print the maintenance list" on page 30
"View maintenance instructions" on page 28
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"View the job status" on page 30

4.3 Apply Filters
Apply a filter
Some filters may be protected. In that case, you must have the Can use system commands right
in order to use them.

1. In the tree view, click the + sign beside the section (Active Maintenance Objects or All
Maintenance Objects) that holds the filter you want to use.
2. Click the name of the filter.
Result: The maintenance list will now show all maintenance objects that fulfil the filter conditions.
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Chapter 4: Command Line Interface
4.4 Maintenance: CommandLineInterface
Using the command line interface you can automatically print maintenance job lists either directly from a
Windows command prompt or from the Job Scheduler program with a fixed interval or activated on an
event in IGSS.
Each maintenance job is printed on its own page, but you can print an overview of the maintenance jobs
which displays all the maintenance jobs on one page or more, depending in the number of maintenance
jobs.

Syntax conventions
The following symbols are used:

Symbol

Description

Bold

Required Parameter

<placeholder>

Placeholder for a variable parameter.

| (Pipe symbol)

Separates required parameters. You must use at least one of
these parameters in the syntax and you may use two or more of
them.
NOTE: To separate these parameters, put a space between
them.

[parameter]

Optional parameter that you may include in the command line.

Syntax
Use the following syntax (separate parameters with a space):
Maintenance.exe -print -active -descriptions -notes -area -soon

Parameter

Description

-print

The maintenance jobs are to be sent to the default printer installed on
the local machine.

-active

Only the active maintenance jobs are to be processed.

-descriptions

Include job descriptions in the list of maintenance jobs.

-notes

Include job notes in the list of maintenance jobs.

-area

Only process maintenance jobs that affect objects created in the
defined area.
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Parameter

Description

Only include the active jobs that are considered to be nearly due.
-soon

A job is considered to be nearly due if the maintenance job progress
percent is equal to or above the value defined in the Maintenance
pending at... field of the Maintenance job form.
Create an overview of the maintenance job list on one page or more if
there are many maintenance jobs.

-simple

Maintenance job descriptions and job notes will not be included in the
overview and the -descriptions and - notes parameters will be ignored
if used.

Job Scheduler example
This example prints all active maintenance jobs for objects in the North area.

Program Path: C:\Program Files\Schneider Electric\IGSS32\V12.0 \ GSS \ Maintenance.exe
Parameters: -active -Area North
Working Folder: Command Prompt Example
This example prints all active maintenance jobs for objects in the North area, but also includes any notes
and job descriptions to the print output.
Maintenance -active - area North -descriptions - notes
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Chapter 4: Form Help
4.5 Maintenance Form
Use this form to:
l

Create and edit maintenance jobs

l

Manage existing maintenance jobs

l

Acknowledge, Re-start and Complete maintenance jobs

l

Print maintenance job lists

l

Create and edit maintenance job filters

l

Change the appearance of the Maintenance job list

The Maintenance form is used by the System Designer and Operator both.

Preconditions
None.

Where do I find it?
In the IGSS Master > Home tab > Maintenance button or IGSS Master > Design and Setup tab >
Maintenance button.

Button Description
Button

Tab and group

Description

Acknowledge

Job Handler
> Maintenance
Job

Click this button to acknowledge a Maintenance job.

Complete

Job Handler
> Maintenance
Job

Click this button to register an acknowledged Maintenance job as
being completed.

Restart

Job Handler
> Maintenance
Job

Click this button to re-start an ongoing Maintenance job.

Click this button to refresh the maintenance job list.
Refresh List

Job Handler
> View

Print

Job Handler
> Job Docu-

The maintenance job list is not refreshed as rapidly as the Alarm list.
Clicking this button re-loads the maintenance job list to display all new
changes to the list.
Click this button to send the Maintenance job list to the local machine's
default printer.
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Button

Tab and group

Description

ments
Open Job
Note

Job Handler
> Job Documents

Click this button to create, read or edit notes on the selected Maintenance job.

Open Job
Help

Job Handler
> Job Documents

Click this button to open the help file associated with the selected Maintenance job.

Open Job
File

Job Handler
> Job Documents

Click this button to open the file associated with the selected Maintenance job.

Job Handler
View Descrip> Job Docution
ments

Find in Super- Job Handler
vise
> Search

New Job

Configuration
> Maintenance
Job

Click this button to open the job description defined for the selected
Maintenance job.
Click this button to locate the Indicator object of the selected maintenance job in the Supervise module .
The Supervise module must be started in order to locate the Indicator
object.
Click this button to create a new maintenance job.
Click the drop-down button to define the maintenance job type when
you create a new maintenance job.
This button is only accessible if you have selected a job in the job list.

New Job on
same Object

Configuration
> Maintenance
Job

Click this button to create a new Maintenance job based on Indicator
Object1 and Maintenance object of the selected job list. You can create different Maintenancejobs types (Periodical, Used time, Counter or
Changes) depending on the Indicator object, but you cannot change
the Indicator Object or Maintenance object.
Click the drop-down button to define the maintenance job type when
you create a new maintenance job.
This button is only accessible if you have selected a job in the job list.

New Job as
Clone

Configuration
> Maintenance
Job

Edit Job

Configuration
> Maintenance
Job

Click this button to create a copy of the selected maintenance job, creating a new maintenance job of the same type. You can change the
Indicator Object or Maintenance objects but cannot change the maintenance job type.
Click this button to edit the parameters of the selected maintenance
job.

1 The object whose values are used to trigger and track the maintenance job.
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Button

Tab and group

Description

Edit Information

Configuration
> Maintenance
Job

Click this button to edit the maintenance job description for the selected maintenance job.
Click this button to open the Filter setup form to create a new filter.

New Filter

Configuration
> Filter

Default

Configuration
> Filter

You must select a filter in the View filters area of the Maintenance
form > Configuration tab before clicking the New Filter button.
Select this checkbox to set the selected filter as a default filter.
A default filter will be run first when opening the Maintenance form

Edit

Configuration
> Filter

Click this button to open the open the Filter setup form to edit the
selected filter

Delete

Configuration
> Filter

Click this button to delete the selected filter

Format
Columns

Configuration
> Job List

Click this button to open the Format Columns form to modify the
columns displayed in the Maintenance form.
You can change the name, width and sort order of the columns as well
as remove or add columns to the maintenance job list display.

Field and Button Description
Field name

Description

Job name

The title of the maintenance job.

Object Name

The name of the Indicator object used to track maintenance progress.
The maintenance job type:

Job Type

l

Periodic

l

User Time

l

Changes

l

Counter

Started

The date the maintenance job was created.

Activated

The date the maintenance job was activated. An active maintenance job is a maintenance job where work is pending

Acknowledged

The date the maintenance job was acknowledged.

Completed

The date the maintenance job was registered as being completed.
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Field name

Description

The present value of the interval used to track the progress of the maintenance job.
Value

The interval itself will depend on the maintenance job type - for example the interval
for a periodic maintenance job set for every week will be weeks.

Progress

The progress of the maintenance job measured as a percent of the elapsed interval
time compared to the

Due In

When the maintenance job is expected to be due in.

Interval

The defined interval for the maintenance job.

Area Name

The name of the area where the Indicator object is placed.

Alarm No.

The alarm number of the alarm defined for the selected maintenance job.

Alarm Text

The alarm text of the alarm defined for the selected maintenance job.

Object
Description

The Indicator object description as it is defined for the Indicator object in the Definition module.

Job Object

The Maintenance object name.
The first column of the job list does not have a title.

First column

Second
column

If the job contains a job description, the first column will display a blue information
icon.
The second column of the job list does not have a title.
If the job contains a job note, the second column will display a yellow note icon.
The third column of the job list does not have a title.

Third column

If the job is linked to another maintenance job, the third column will display a colored
marker. The maintenance job that is linked to will also display the same colored
marker in the third column, enabling quick overview of any linked maintenance jobs in
the job list.

4.6 The New / Edit Periodical Job Form
Use this form to create a new periodical job for an analog, digital or counter object in the IGSS configuration.
You can also use this form to edit an existing periodical job in the Maintenance form. When used to edit an
existing Maintenance job, the form title will change to Edit Periodical Job (Job title).
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Preconditions
If you utilize user administration, the current user must have the Can Define right to create maintenance
jobs.

Where do I find it?
In the Maintenance form > Configuration tab > Maintenance Job group, click the New Job button to
open the Select Maintenance job type and Indicator object form.
In the Select Job Type and Indicator Object form, select the Periodical option and then select the
Indicator object you want to create the maintenance job for. Click the OK button to open the New Periodical Job form.
You can also click the drop down menu in the New Job button and directly select the type of job you want
to create.

Field Help
Field name

Description

Title

Type a meaningful name to describe the maintenance job. The job title will
be displayed in the Job Name column in the Maintenance list.
Click this button to copy the alarm text title to the Job Title field.

Use Alarm Text

This is very useful if you want the operator to see the same title in both the
Maintenance List and in the Alarm List.
The object whose values are used to trigger the maintenance job. In many
cases, the Indicator object will be identical with the Maintenance object.

Indicator Object

The Indicator object is defined when you create the Maintenance job. You
cannot change the Indicator object or the Maintenance object once the maintenance job has been created. Delete the Maintenance job and create a new
job if you have to make changes to the Indicator or Maintenance objects.
The object on which the actual maintenance is to be performed.

Maintenance Object

Change (button)

The Maintenance object is defined when you create the maintenance job and
is by default identical to the Indicator object.
Click this button to open the Job Object for Maintenance Job form where
you can select a new Maintenance object for the job.
This button is only enabled in the New Periodical Job form.

Periodical Interval

Define the periodical interval by typing the appropriate number in the first
box and then selecting the time unit in the drop-down list.
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Field name

Description

Note: When the maintenance interval expires, a maintenance alarm
will appear in the Active Maintenance Jobs section of the maintenance list and, if you have attached an alarm text, an alarm appears
in the Active Alarms section of the alarm list.

First Activation

Define when the periodical interval set up for maintenance is to start. You
can define a start date and time.
Select the alarm text that you want to show in the alarm list, when the specified service interval has expired.

Alarm fired when job is
due

It is recommended to attach alarm texts to all maintenance jobs to
ensure that the operator will see the maintenance alarm immediately
in the alarm list. If no alarm text is attached, the maintenance alarm
will only occur in the maintenance list. Another advantage is that you
can attach a sound to an alarm text to indicate the alarm’s seriousness
to the operator.
Link the Maintenance job an existing maintenance job in the Maintenanceform.

Link Maintenance job

If you acknowledge, restart or complete a linked Maintenance jobs, you can
chose to acknowledge, restart or complete the Maintenance job that is linked
to as well.
Set the progress percent which will define when the Maintenance job is considered to be nearly due.

Maintenance pending
at...

You can use the maintenance pending to print a list of Maintenance jobs that
will be due in the near future by using command line parameters.
The default value is 95.
In this section there is four tabs: Job Description, Job Note, File/Folder
and Help File.
You can here supply with some information to the job by attaching files to it.
In the Job Description tab you can for example attach a text file with a
description for the operator.

Attach files to the job

Depending on what kind of file you want to attach, you should use the appropriate tab.

If you have attached a description to the job, the View Description
button will appear under the Job Handler tab in the Job Documents
ribbon.
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See Also

4.7 The New / Edit Used Time Job Form
Use this form to create a new User Time job for a digital object in the IGSS configuration.
You can also use this form to edit an existing User Time job in the Maintenance form. When used to edit an
existing Maintenance job, the form title will change to Edit Used Time Job (Job title).

Preconditions
If you utilize user administration, the current user must have the Can Define right to create maintenance
jobs.

Where do I find it?
In the Maintenance form > Configuration tab > Maintenance Job group, click the New Job button to
open the Select Maintenance job type and Indicator object form.
In the Select Job Type and Indicator Object form, select the Used Time option and then select the
Indicator object you want to create the maintenance job for. Click the OK button to open the New Used
Time Job form.
You can also click the drop down menu in the New Job button and directly select the type of job you want
to create.

Field Help
Field name

Description

Title

Type a meaningful name to describe the maintenance job. The job title will
be displayed in the Job Name column in the Maintenance list.
Click this button to copy the alarm text title to the Job Title field.

Use Alarm Text

This is very useful if you want the operator to see the same title in both the
Maintenance List and in the Alarm List.
The object whose values are used to trigger the maintenance job. In many
cases, the Indicator object will be identical with the Maintenance object.

Indicator Object

The Indicator object is defined when you create the maintenance job. You
cannot change the Indicator object or the Maintenance object once the maintenance job has been created. Delete the Maintenance job and create a new
job if you have to make changes to the Indicator or Maintenance objects.

Maintenance Object

The object on which the actual maintenance is to be performed.
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Field name

Description

The Maintenance object is defined when you create the maintenance job and
is by default identical to the Indicator object.

Change (button)

Click this button to open the Job Object for Maintenance Job form where
you can select a new Maintenance object for the job.
This button is only enabled in the New Used Time Job form.
Define the maintenance interval for the first time you want maintenance
on this object. Type the appropriate number in the first box and then select
the time unit in the drop-down list.
When the maintenance interval expires, a maintenance alarm will appear in
the Maintenance Jobs due section of the maintenance list and, if you have
attached an alarm text, an alarm appears in the Active Alarms section of
the alarm list.

Job due after
Tip: You may want to have a shorter maintenance interval the first
time you maintain a new process component and then use the same
interval for the subsequent times. This is simply done by defining the
first interval as described above and then selecting the new interval in
the Add to limit box. For example, you might want to check a pump
after 10 hours of operation and then only every 30 hours after the first
check.
Reset accumulated
value

Select this option to reset the current accumulated value to 0 when the operator completes a maintenance alarm on this object.

Next job after

Select this option if you want to add a specific interval to the current accumulated value, and offset the next job. Type this interval in the box to the
right.

States

Select the digital states that you want this maintenance interval to apply to.
Select the alarm text that you want to show in the alarm list, when the specified service interval has expired.

Alarm fired when job is
due

It is recommended to attach alarm texts to all maintenance jobs to
ensure that the operator will see the maintenance alarm immediately
in the alarm list. If no alarm text is attached, the maintenance alarm
will only occur in the maintenance list. Another advantage is that you
can attach a sound to an alarm text to indicate the alarm’s seriousness
to the operator.

See Also

- 42 -

IGSS V12, User Guide

4.8 The New / Edit Changes Job Form
Use this form to create a new Changes job for a digital object in the IGSS configuration.
You can also use this form to edit an existing Changes job in the Maintenance form. When used to edit an
existing Maintenance job, the form title will change to Edit Changes Job (Job title).

Preconditions
If you utilize user administration, the current user must have the Can Define right to create maintenance
jobs.

Where do I find it?
In the Maintenance form > Configuration tab > Maintenance Job group, click the New Job button to
open the Select Maintenance job type and Indicator object form.
In the Select Job Type and Indicator Object form, select the Changes option and then select the
Indicator object you want to create the maintenance job for. Click the OK button to open the New Periodical Job form.
You can also click the drop down menu in the New Job button and directly select the type of job you want
to create.

Field Help
Field name

Description

Title

Type a meaningful name to describe the maintenance job. The job title will
be displayed in the Job Name column in the Maintenance list.
Click this button to copy the alarm text title to the Job Title field.

Use Alarm Text

This is very useful if you want the operator to see the same title in both the
Maintenance List and in the Alarm List.
The object whose values are used to trigger the maintenance job. In many
cases, the Indicator object will be identical with the Maintenance object.

Indicator Object

The Indicator object is defined when you create the maintenance job. You
cannot change the Indicator object or the Maintenance object once the maintenance job has been created. Delete the Maintenance job and create a new
job if you have to make changes to the Indicator or Maintenance objects.
The object on which the actual maintenance is to be performed.

Maintenance Object

Change (button)

The Maintenance object is defined when you create the maintenance job and
is by default identical to the Indicator object.
Click this button to open the Job Object for Maintenance Job form where
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Field name

Description

you can select a new Maintenance object for the job.
This button is only enabled in the New Changes Job form.

Job due after

Type the number of state changes you will allow before maintenance must
be performed on this process component. The states that you want to count
are specified by clicking Select States and then choosing the relevant
states. You may, for example, only want to count the number of times that
the pump entered the On state.
When the maintenance interval expires, a maintenance alarm will appear in
the Maintenance Jobs Due section of the maintenance list and, if you have
attached an alarm text, an alarm appears in the Active Alarms section of
the alarm list.

Reset accumulated
value

Select this option to reset the current accumulated value to 0 when the operator completes a maintenance alarm on this object.

Next job after

Select this option if you want to add a specific number of changes to the current accumulated number of changes. Type this number in the box to the
right.

Count on state change
to (0)

Change the count on state change to (0).
Select the alarm text that you want to show in the alarm list, when the specified service interval has expired.

Alarm fired when job is
due

Link Maintenance job

It is recommended to attach alarm texts to all maintenance jobs to
ensure that the operator will see the maintenance alarm immediately
in the alarm list. If no alarm text is attached, the maintenance alarm
will only occur in the maintenance list. Another advantage is that you
can attach a sound to an alarm text to indicate the alarm’s seriousness
to the operator.
Link the Maintenance job an existing maintenance job in the Maintenanceform. If you acknowledge, restart or complete a linked Maintenance
jobs, you can chose to acknowledge, restart or complete the Maintenance
job that is linked to as well.
Set the progress percent which will define when the Maintenance job is considered to be nearly due.

Maintenance pending
at...

You can use the maintenance pending to print a list of Maintenance jobs that
will be due in the near future by using command line parameters.
The default value is 95.

Attach files to the job

In this section there is four tabs: Job Description, Job Note, File/Folder
and Help File.
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Field name

Description

You can here supply with some information to the job by attaching files to it.
In the Job Description tab you can for example attach a text file with a
description for the operator.
Depending on what kind of file you want to attach, you should use the appropriate tab.

If you have attached a description to the job, the View Description
button will appear under the Job Handler tab in the Job Documents
ribbon.

See Also

4.9 The New / Edit Counter Job Form
Use this form to create a new Counter job for an analog or counter object in the configuration.
You can also use this form to edit an existing Counter job in the form. When used to edit an existing job,
the form title will change to Edit Counter Job (Job title).

Preconditions
If you utilize user administration,the current user must have the Can Define right to create maintenance
jobs.

Where do I find it?
In the Maintenance form >Configuration tab > Maintenance Job group, click the New Job button to
open the Select job type and Indicator object form.
In the Select Job Type and Indicator Object form, select the Counter option and then select the Indicator object you want to create the maintenance job for. Click the OK button to open the New Used Time
Job form.
You can also click the drop down menu in the New Job button and directly select the type of job you want
to create

Field Help
Field name

Description

Title

Type a meaningful name to describe the maintenance job. The job title will
be displayed in the Job Name column in the Maintenance list.
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Field name

Description

Click this button to copy the alarm text title to the Job Title field.
Use Alarm Text

This is very useful if you want the operator to see the same title in both the
Maintenance List and in the Alarm List.
The object whose values are used to trigger the maintenance job. In many
cases, the Indicator object will be identical with the Maintenance object.

Indicator Object

The Indicator object is defined when you create the maintenance job. You
cannot change the Indicator object or the Maintenance object once the maintenance job has been created. Delete the Maintenance job and create a new
job if you have to make changes to the Indicator or Maintenance objects.
The object on which the actual maintenance is to be performed.

Maintenance Object

Change (button)

The Maintenance object is defined when you create the maintenance job and
is by default identical to the Indicator object.
Click this button to open the Job Object for Maintenance Job form where
you can select a new Maintenance object for the job.
This button is only enabled in the New Counter Job form.
Type the count you will allow the counter object to reach before maintenance must be performed.

Job due when value
reaches

Reset value

When the maintenance interval expires, a maintenance alarm will appear in
the Maintenance Jobs Due section of the maintenance list and, if you have
attached an alarm text, an alarm appears in the Active Alarms section of
the alarm list.
Select this option to reset the accumulated value to 0 when the operator
completes an alarm on this object.
Type the value you want to add to the service interval when the maintenance
should be done the second time and subsequently.

Increase reached value
with

This allows you to define a short first service interval and subsequently a
longer interval. This is useful for new process components where you typically want to perform maintenance quickly to verify that the component is
running as expected.
Select the alarm text that you want to show in the alarm list, when the specified service interval has expired.

Alarm fired when job is
due

It is recommended to attach alarm texts to all maintenance jobs to
ensure that the operator will see the maintenance alarm immediately
in the alarm list. If no alarm text is attached, the maintenance alarm
will only occur in the maintenance list. Another advantage is that you
can attach a sound to an alarm text to indicate the alarm’s seriousness
to the operator.
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Field name

Description

Link Maintenance job

Link the Maintenance job an existing maintenance job in the Maintenanceform. If you acknowledge, restart or complete a linked Maintenance
jobs, you can chose to acknowledge, restart or complete the Maintenance
job that is linked to as well.
Set the progress percent which will define when the Maintenance job is considered to be nearly due.

Maintenance pending
at...

You can use the maintenance pending to print a list of Maintenance jobs that
will be due in the near future by using command line parameters.
The default value is 95.
In this section there is four tabs: Job Description, Job Note, File/Folder
and Help File.
You can here supply with some information to the job by attaching files to it.
In the Job Description tab you can for example attach a text file with a
description for the operator.

Attach files to the job

Depending on what kind of file you want to attach, you should use the appropriate tab.

If you have attached a description to the job, the View Description
button will appear under the Job Handler tab in the Job Documents
ribbon.

See Also
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4.10 Filter Setup Form

Overview
This form allows you to set up filters that limit the maintenance list to show only those maintenance jobs
that fulfil certain conditions.

Preconditions
You have to select one of the two sections in the tree view (Maintenance Jobs Due or All Maintenance
Jobs). The new filter will then appear in the tree view as a subsection.

Where do I find it?
Click the New Filter button to open the Filter Setup form.

Field Help
Field name

Description

Give the filter a descriptive name. When you later want to apply this filter, you simply
click its name in the tree view.
Filter name

Tip: It is recommended to use short, descriptive names for
the filters so that the operator will immediately recognize its
function. For example, you may want to create a filter which
only shows all maintenance jobs which are more than 80 %
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Field name

Description

fulfilled. In that case, the name could be Percent > 80.
Shows the filter pass condition(s) defined for this filter.
Filter Pass
Conditions

To add a new filter condition, define its properties in the Condition Editor group, then
click Add.
To change a filter condition, select it in the Filter Pass Conditions list, then edit the
necessary properties in the Condition Editor group, then click Change.
Check this box to negate the filter condition(s) shown in the Filter Pass Conditions
list.

Invert
Condition
(s)

Note: You may want to view the maintenance jobs for all objects except a specific
type of process component, for example, all pumps. In that case, specify that you
want all objects starting with p in the filter and then check the Invert Condition
box to show all objects except the pumps in the maintenance list.

Add Condition

Adds the condition you defined in the Condition Editor group to the Filter Pass Conditionslist.

Remove
Condition

Deletes the selected condition in the Filter Pass Conditions list. Note that you can
delete each condition individually. You need not delete the whole expression.

And

Select this option if you want this condition as well as other And conditions to be fulfilled. This is typically used to create a “narrow” filter, for example, show all objects
starting with p that belongs to the Process A area.

Or

Select this option if you want this condition or other conditions to be fulfilled. This is typically used to create an either/or filter. You may, for example, want to show all maintenance jobs which use either the Used Time or Changes type of maintenance. This is
done by combining the two conditions as Or conditions. In this case, select Maintenance Type is exactly Used Time and Mnt Type is exactly Changes.

Property

Select the property in the drop-down list that you want to create a condition for. The list
of properties include most of the columns you see in the maintenance list. When you
have selected the appropriate property, use the Operator and Value boxes to specify
the exact condition. When you are satisfied with the condition, click Add.

Operator

Select the operator you want to apply to the selected property. The choices depend on
the selected property as they are different for text columns, date/time columns and
value columns. When you have selected the appropriate operator, select the Value that
the operator must conform with.

Example: To show all objects in the Global area, select is exactly in the Operator list, then type Global in the Value box.
Value

Type the value you want the condition to conform to or select an item in the drop-down
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Field name

Description

list.

Example: To show all objects using the Used Time maintenance type, select Mnt
Type in the Condition list, then select Used Time in the Value list.
Check this box to protect this filter. To make the protection work, you must define users
and user rights in the User Administration application.
Protect

Note: Only users with the Can System Commands right will be allowed to use
this filter. If an unauthorised user tries to apply it, the Temporary Login dialogue
will appear. This will allow another user with the necessary right to log in.

4.11 Format Columns form

Overview
You may want to customize the maintenance list for the following reasons:
l

You want to change the column sequence to show the columns that are most important for you first

l

You want to change the sort order to show the most important maintenance alarms first

Where do I find it?
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Click the
button under the Configuration tab in the Job List ribbon, to open the Format
Columns form. In this form, you decide exactly which columns to show, their order and even their names.

Field Help
Field name

Description

Move Up

Moves the selected column one position up in the list. Remember that the
first column name is the primary sorting key.

Move Down

Moves the selected column one position down in the list. Remember that the
first column name is the primary sorting key.

Add >

Select a column name and click add to move it to the Displayed ones.

Remove <

Select a column name and click remove to remove it from the Displayed
ones and put it in the Available ones.

Custom Name

Change the name of a column to a name of your choice.

Width

Customize the size of the column (in pixels).

Reset

Restore the default names and widths of the columns.

4.12 Job Information Form

Overview
To make sure that a maintenance job is performed correctly and consistently by the plant operators, you
must supply precise and adequate step-by-step instructions.
You can also supply maintenance instructions in the form of an electronic file (a video clip, an electronic
manual, etc.) or as a Help file.

Preconditions
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You have to click on the job you want to edit before you can click on the Edit Information button.

Where do I find it?
Click the Edit Button button on the Configuration tab in the Maintenance Job ribbon, to open the Job
Information form.

Field Help
You can hereunder find the field help for the different job informations:

Job Description
Field name

Filename

Description

Type the file name for the file that will contain the job description that you
type in the box below. There are no file name requirements, but it is recommend to use the same extension to easily recognize maintenance job description files. This extension could be *.job. The file will be placed in the report
folder defined for the active configuration.
You can use any editor to edit the file, but operators must press the Refresh
button to update the contents on the Job Description tab.

Refresh

Updates the job description with the contents of the file specified in the Filename box. This file is placed in the report folder defined for the active configuration.

Browse

Click here if you already have a text file containing the maintenance job
description or job note. This is useful if you want to reuse existing job
descriptions for different maintenance jobs.

Job Note
Field name

Filename

Description

Type the file name for the file that will contain the job note that the operators will type in the box below. There are no file name requirements, but it
is recommend to use the same extension to easily recognize maintenance
job note files. This extension could be *.not. The file will be placed in the
report folder defined for the active configuration.
You can use any editor to edit the file, but operators must press the Refresh
button to update the contents on the Job Note tab.

Refresh

Updates the job note with the contents of the file specified in the Filename
box. This file is placed in the report folder defined for the active configuration.

Browse

Click here if you already have a text file containing the maintenance job
description or job note. This is useful if you want to reuse existing job
descriptions for different maintenance jobs.

File/Folder
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Field name

Description

Location

Type the path and filename of the file that contains maintenance instructions. This file could be a video clip (*.avi), an electronic manual (for
example, in *.pdf format), etc. You can also use the Browse button to find
the relevant file.

Select file

Click this to find the file that contains maintenance instructions which will
help the operator perform the maintenance job.

Select folder

Click this to find the folder that contains maintenance instructions which will
help the operator perform the maintenance job.

View

Click here to view the file you have selected in the associated program. For
example if it's a .txt file, notepad will startup and display the file.

Help File
Field name

Description

Help File

Type the path and filename of the Help file (*.hlp; *.chm) that contains maintenance instructions for this job. You can also use the Browsebutton to find
the file.

Browse

Click this to find the Help file (*.hlp; *.chm) that contains maintenance
instructions for this job.

Index

Type the exact topic ID of the topic you want to show. Use your Help authoring tool to find the topic ID.

View

Click this to view the Help file. If you have specified an ID in the Index box,
this Help topic will be shown.
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4.13 Object Selection for Maintenance Job Form

Overview
This dialog box allows you to choose the type of maintenance job you want to create for a selected object.

Where do I find it?

Click on the New Job button

in the Maintenance Job ribbon under the configuration tab.

Field Help
Field name

Description

Periodical

Check this box to create a periodical maintenance job for the selected
object.

Used Time

Check this box to create a maintenance job based on used time for the selected object.

Changes

Check this box to create a maintenance job based on the number of state
changes for the selected object.

Counter

Check this box to create a counter-based maintenance job for the selected
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Field name

Description

object.
Filter

Select a filter in the drop-down and then write what it should correspond to
in the text field.

Negate filter

If you check this checkbox, the filter you chose will be negated.
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Chapter 5: Reference and Lookup
5.1 Getting Help in IGSS
IGSS comes with a comprehensive help system designed to help both system designers and operators to
get started with IGSS as quickly as possible.

Documentation overview
The IGSS documentation includes the following items:

Documentation item

Description

Getting Started

An introduction to IGSS and its most fundamental terms and features.
Getting Started is intended to get you up and running as fast as possible. The manual provides a system and architecture overview followed by a number of real-life use cases you can go through before
building your first real IGSS project. The manual is available in Adobe
Acrobat format (.pdf).
For each module there is a help file with the same name as the module
itself, for example, Def.chm for the Definition module.

Module help

The help file is invoked by clicking the
in the upper right corner of
the module. The Table of Contents will then allow you to browse
through the topics.
For each Form or dialog there is a help topic with the following standard information:

Form and Dialog help̓

l

Overview

l

Preconditions

l

Where do I find it?

l

Field help

Form help is invoked by clicking the help button
in the upper right
hand corner of the dialog box or located in the Table of Contents of the
individual help file.

Thematic help

IGSS also provides thematic help. When there is a special theme that
requires special attention from the user, a dedicated help file is
provided. Examples include "Driver-Specific Help" and "Database
Administration Help".

Where are the help files located?
The IGSS help files are located in the appropriate language folder in the installation path of IGSS, by
default C:\Program Files\Schneider Electric\IGSS32\V12.0. The help files are available in English at
release time.
The paths to the help files are:
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Language

Path

English

[IGSS InstallPath]\ENG

Danish

[IGSS InstallPath]\DAN

German

[IGSS InstallPath]\DEU

Translated help files
Selected help files have been translated into Danish. If you require help files in your language, please contact Schneider Electric.

Help updates
The help files are continuously updated and improved. Check regularly with the IGSS Update in the IGSS
Master.

5.2 Conventions in this Manual
The following typographical conventions are used:

Convention

Description

Example

User interface element

When referring to labels and names
in the user interface.

User input

When the user has to type specific
data in IGSS

The Data Management tab.

Type the following description:

Incoming flow in Tank 2

Module
name

When referring to a module in IGSS

Note

A note emphasizes or supplements
important points of the main text. A
note provides information that may
apply only in special cases.

Tip

A tip suggests alternative methods
that may not be obvious in the user
interface. A tip also helps the user in
working more effectively with IGSS.
A tip is not essential to the basic
understanding of the text.

Alternative to this simple
find function, you can also filter on text in the messages
in Driver Log Filters dialog
box.

Warning

A warning is an important note that is
essential for the completion of a

If you disregard the System

Open the Definition module.

By default, the timestamp is in universal
time format, UTC1. This can be changed in
the Driver Log Filters dialog box.

1 Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating time in

most parts of the world. IGSS uses this time format internally in the database. You can switch between UTC
and local time by enabling or disabling the "UTC" field in various dialog boxes in the system.
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Convention

Description

Example

task. In some cases, disregarding a
warning may result in undesirable
functionality or loss of data.

alarm, you may risk loss of
data in the LOG and BCL
files.

5.3 Version Information (IGSS Help System)
© Schneider Electric, IGSS Version 12.0
The IGSS help files are based on software build number 10305 (initial release)

English help files
To update the help files, click the Update IGSS Software button on the Information and Support tab
in the IGSS Master . There must be a connection from the PC to the Internet. Every time IGSS Update is
run, IGSS help files as well as IGSS system files will automatically be updated on the PC from the web
server at Schneider Electric.
You select the languages you want to update in the Tools menu of the IGSS Update form.
If you are not able to update the IGSS system directly via the Internet, the alternative is to download the
updates from the Schneider Electric website as zip files. These can then be transferred onto a CD or USB
memory stick, which is then the medium used to update on site.

After updating your IGSS installation , the build numbers in various IGSS modules may change to a
higher number. This signifies that the module in question has been updated with newer files. Build
numbers consist of four digits, where the first digit represents the year and the last three represent
the day number in the year in question. The build number can be seen in the About dialog box which
can be activated from the Help menu.
An example:

Build number = 10305
16 = the year 2016
305 = The 305th day of the year
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Chapter 6: Glossary
A
Application menu
The Application menu is the first ribbon in the IGSS Master module. Click the icon to drop down
the menu. The menu contains items that were typically found in the File menu in previous versions of IGSS. In most modules, an "Options" item allows the user to define global module settings. The Application menu was introduced in the Microsoft Office 2010 package. It replaces the
Application button (nicknamed Doughnut) which was introduced in IGSS V7 and V8.

D
descriptor
A descriptor is the graphical display of an object. IGSS includes many types of descriptors including: - Built-in standard symbols - Animated symbols (Symbol Factory library) - Graphics and
animation - Drawing symbols - Windows controls - ActiveX controls An IGSS object can be represented with different descriptors on different diagrams.

I
Indicator Object
The object whose values are used to trigger and track the maintenance job.

M
Maintenance Object
The object on which the actual maintenance is to be performed.

R
Ribbon
The Ribbon is a new term/element in the Microsoft universe. The Ribbon replaces the well-known
toolbars in applications. The Ribbon provides quick access to the most commonly used functions
in the application. The Ribbon is divided into logical groups (the tabs) and each tab is divided into
sections (the blocks in the tab). The Ribbon is context-sensitive which means that only relevant
functions are accessible dependent on the current user action.

S
SCADA
Supervisory Control & Data Acquisition
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U
UTC
Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating
time in most parts of the world. IGSS uses this time format internally in the database. You can
switch between UTC and local time by enabling or disabling the "UTC" field in various dialog boxes
in the system.
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